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TRICASTER SUPPLEMENT 

 

 

LiveText is an integrated component of TriCaster’s software suite, 

and provides unique capabilities in that context.  In consequence, 

its operations and interface vary in a few respects as compared to a 

standalone installation. 

Among these distinctive characteristics is LiveText’s recognition of 

TriCaster sessions, export of TriCaster Title Pages (.cgxml files), as 

well as support for its hardware output options.  This supplement 

will acquaint you with these important details. 

 

 

WHEN LIVETEXT IS INTEGRAL TO TRICASTER, NO FURTHER INSTALLATION OR 

REGISTRATION STEPS ARE REQUIRED.   

 

1.1 SESSIONS, PROJECTS AND DISPLAY 

LiveText projects are launched from the Session Page in TriCaster’s Startup Screen.  After 

creating a new session or opening an existing one, click the Graphics icon on the rotating 

function selector ring.  This reveals options and links at right. 

LiveText uses the current session settings for output to TriCaster video outputs, new projects 

(created within the LiveText File menu or from the Session Page) and bitmap file exports.  If you 

use the File menu to Open a project whose settings do not correspond to the current session 

settings, TriCaster will attempt to display it on its hardware video outputs if possible. 

LiveText sends output from the canvas to TriCaster’s outputs continuously while running.  For 

this reason, the Live Display pane and associated tools that appear at upper-right (above the 

Pages Panel) in LiveText standalone do not appear in TriCaster’s LiveText interface. 
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When LiveText is running, TriCaster’s video outputs (rows 1-3) will all conform to the session 

format.  That is, if the project is HD, the SDI outputs will all be HD, and the analog outputs will be 

Component HD.   

Likewise when the project is SD, the SDI outputs will all be SD.   As there are multiple connection 

options for analog SD video, please refer to the following table in this case: 

Row Number SDI Analog BNC 1 Analog BNC 2 Analog BNC 3 

1 SD Y Pb Pr 

2 SD Composite Y C 

3 SD Composite Y C 

 

Note: It is possible to use LiveText’s File menu to open a project that does not correspond 

to the current session settings. TriCaster will attempt to provide video output, but it’s 

possible that a given monitor may not display it correctly.  

 

1.2 FILES/FILEBIN  

LiveText’s file dialogs (for File>Open, File>Add, File>Save and Save As) have pre-configured 

QuickTabs pointing to the following default paths for the current session. 

Note: the Quicktab links refer to ‘session-dependent’ paths, thus are not permanent.  

That is, for a given session, the path the Quicktab refers to is established at launch time. 

For this reason, the TriCaster version of LiveText does not support user-added Quicktabs. 

LiveText’s File menu has two special items – Send Current Page to Live, and Send All Pages to 

Live.   As you would expect, these creates files for use in the Live Desktop, and store them in the 

correct place(s) for easy access.   
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Titles prepared in LiveText can be either still or motion pages.  When you send a still page to Live, 

it becomes a Title Page file, with the characteristic filename extension “.cgxml”.  Title Page files 

can be edited in the Live Desktop’s Media Players.  Send Current Page to Live will automatically 

store these files in the D:Media\Titles\sessionname\projectname folder.   

Motion pages (scrolls and crawls) sent to Live are stored as bitmap animation files (with an .avi 

file extension), suitable for playback in Live Desktop’s DDR.  These are sent to the session folder 

inside TriCaster’s main Clips folders.  Motion page content cannot be edited in the Live Desktop. 

When you select Send All Pages to Live, each page in the project is exported in turn to the 

appropriate format and location.  This means they are readily accessible in the Live Desktop’s 

Media Browser afterward, for easy addition to a Media Player playlist.  Title Page icons will 

appear grouped under their project names in the Media Browser’s File Pane when you select the 

session name in the Location List at left. 

1.3 NAMING STAND-IN IMAGES 

Among other things, the Title Editor in TriCaster’s Media Players (DDR, Stills and Titles) allows 

you to substitute a different image for stand-in (or “placeholder”) images in Title Pages (.cgxml) 

exported from LiveText.  Details on replacing stand-in images are found in the TriCaster manual. 

When creating title pages for this purpose in LiveText, you may find it saves you time to add the 

string “_placeholder” somewhere in the filename of images you prepare for this purpose.  For 

example, you might name an image "headshot_placeholder.png", or "_PLACEHOLDER_crest.jpg". 

Images named in this manner will automatically appear as stand-in images (unlocked) in the Title 

Pages you export to TriCaster using the Send to Live options in LiveText’s File menu. 

NOTE: Images with Shadow or Edge options enabled cannot serve as ‘stand-in images’. Also, 

image-mapped (textured) objects cannot serve stand-ins. (Drag the placeholder image onto the 

canvas from the File bin rather than texturing and object). 

1.4 MANUAL CHAPTER NUMBERING 

You may notice that a few chapter or section numbers seem to be missing in this edition of the 

LiveText manual.  This is deliberate, so that reference numbers for the documentation for the 

TriCaster and standalone installations will be the same.  (Certain sections, such as details of 

registration and installation, are irrelevant for TriCaster and thus omitted from this version of the 

manual.)
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2 INTRODUCTION 

 

 
LiveText greatly extends the live production environment, providing a 
new level of creativity, confidence, and professionalism! 
 
Users of compatible live production systems (like NewTek’s famous 
TriCaster™ family) are the primary beneficiaries.  LiveText multiplies 
creative opportunities and brings new depth to production capabilities. 
 

 

2.1.1 MANUAL ORGANIZATION 

 
While powerful, LiveText is quite intuitive.  If you have some basic familiarity with graphics 
applications, much of it will come naturally.  Or, if you’re familiar with the similar titling 
capabilities as a result of experience with other NewTek products, you’ll feel right at home. 
 
Chapter 3 (Getting Started) will help you connect LiveText to your live production network. Next, 
in Chapter 4 (Titling Tools) you’ll explore LiveText’s title page creation and management tools.  
Chapter 5 explains how to use LiveText titles in your live production environment (as well as 
other applications.) 
 
An Appendix provides information on handy keyboard shortcuts (for the truly adventurous, keep 
reading long enough, and you’ll even ultimately stumble across our names!) 
 

NOTE: A FEW OPERATIONAL DETAILS VARY WHEN LIVETEXT OPERATES AS AN INTEGRATED 
COMPONENT OF TRICASTER™ LIVE PRODUCTION SYSTEMS.  SEE THE ‘TRICASTER 
SUPPLEMENT’ AT THE BEGINNING OF THIS MANUAL FOR DETAILS. 
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3 GETTING STARTED 

 

 
This chapter will help you establish a network connection between 
LiveText™ and your (compatible) live production system. 
 
We will review recommended networking procedures and connection 
troubleshooting. 
 

 

 

NotesA SIMPLE EXAMPLE 

Let’s try creating a simple title page: 

1. Click the T in Text and Drawing, then click in the Canvas to set the insertion point. 

 

 

Figure 7 

2. Type “LiveText”, press Enter, then type “Productions” 

 



 

8 

 

Figure 8 

3. Click the Arrow (Select) button, and drag out a box (marquee) to surround both lines of 

text on the Canvas, selecting them (Figure 8). 

 

 

Figure 9 

4. Click the Style tab (below the Canvas), and then click thumbnail number 4 in the Styles 

bin area.  This will immediately add color and beveling to the (selected) text you entered 

previously. 

 

 

Figure 10 
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5. Click the View tab, and turn on Safe Area, to help compose your page 

 

 

Figure 11 

6. Next, click both the Vertical and Horizontal Center buttons in the Alignment section of 

the Tool Panel, centering the text on the Canvas. 

 

Figure 12 

7. With both lines of text still selected, click Group (in the Alignment section) to link them 

together. 

 

 

Figure 13 
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8. Then drag a corner point of the grouped text to make it larger (use your judgment, using 

the Safe Area overlay as a guide – the inner rectangle denotes the traditional ‘text safe’ 

margin.) 

 

 

9. Click the Filled Rectangle button in Text and Drawing 

 

Figure 14 

10. Click thumbnail number 6 in the Styles tab, and drag out a rectangle in the Canvas that 

completely covers your text. 

 

 

Figure 15 

11. Select the rectangle (using the Arrow tool), and click Send Backward in the Alignment 

section 
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Figure 16 

12. Go on to adjust Tracking, Leading in the tabbed Text and Drawing controls beneath the 

Canvas, and finish up by adding a Shadow to your text. 

 

 

Figure 17 

3.5 USING LIVETEXT TEMPLATES 

A large number of gorgeous and very useful Text Templates are included with LiveText, to speed 

you on your way.  You can easily modify these to suit your own production designs. 
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Figure 18 

1. Select Add Page from the drop-down menu in the Pages panel at right 

 

2. As you slide your mouse down the list, notice that a thumbnail fly-out keeps pace 

showing a preview for each template 

 

3. Select Slate 1, loading that template into the Canvas for modifications 

 

 

Figure 19 

4. Click the T button (Text), and slide you mouse around over the text fields in the 

Canvas 

 

5. Notice that a black outline surrounds each text line in turn.  Select the text inside 

one of these outlines, and change it to suit your need. 
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Figure 20 

Congratulations, with LiveText you’re a CG artist.  Could it be any easier?  
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4 TITLING TOOLS 

 

 
Designing and managing great looking still and animated text and 
graphics for your productions is easy with LiveText. It’s deep professional 
character generation tools will provide a clean, professional looking 
result you’ll be proud to broadcast! 
 
 

 

 

4.1 LIVETEXT OVERVIEW 

The main panel is dominated by the large 

cental Canvas, which provides an 

interactive display of the current project 

page. 

The column at left is a Tool Panel for 

creating and editing visual elements, 

including text.  LiveText’s File menu is 

above this column. 

The Motion Panel is located just below the 

Canvas.  It permits you to create animated 

scrolls or crawls. 

Right beneath the Motion Panel is the 

tabbed Control Panel, which gives you 

control over attributes of text and graphic objects. 

Finally, a column on right of the Canvas provides multi-page management (the Pages panel) of 

your project, file Load, Save and Export functions, and at the top – the all important Live Preview 

pane (not shown when LiveText is integrated in TriCaster™). 

Figure 21 
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4.2 OUTPUT ASPECT (4:3 OR 16:9?) 

You may be wondering whether you need to consider the image aspect of your LiveText projects.   

LiveText 2.0 projects are effectively aspect independent.  The Canvas where you prepare your 

title pages is always 16:9.  When exporting title pages as bitmap (image) files for external use, 
you manually choose the resolution and image aspect from the export dialog.  When you choose 
4:3, only the center part of 16:9 title pages will be exported.  The Safe Area overlay has 4:3 page 
edge and text safe lines to make this easy to visualize. 
 

4.3 PROJECT PAGE MANAGEMENT 

LiveText projects consist of one or more pages. If you want one main introductory title, another 

title for a station ID, an animated list of scrolling credits for the end, and so on – each of these is 

created as a separate page within the whole project. 

Completed pages may be exported (using 

Export Current Page or Export All Pages in the 

File menu) for use in other programs 

supporting .cg files (including NewTek’s 

SpeedEDIT and VT[5]), as image (.PNG) or 

animation (.avi) files, or as Title Pages (.cgxml) 

compatible with TriCaster XD systems.  

Exported .cg files can be further processed 

externally to become Custom Templates, or 

even LiveSets - see Section 5.2.1.3.) 

 

Entire projects can also be saved and re-loaded later, allowing you to work with one design for 

one production while a completely different look for another is only a few clicks away. 

Note: Project and page files (.cg files) created with earlier versions of LiveText came in 

4:3 and 16:9 formats.  If you load one of these older files into LiveText 2.0, you will be 

asked whether you wish to load it as 4:3 (centered on the page), or as 16:9 (filling the 

screen). 

Figure 22 
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4.3.1 THE PAGES PANEL 

The Pages panel at the right of the Canvas displays a thumbnail image of each page in the 

current project, and provides page management tools.  A new project will show one (empty) 

page.  When a project has multiple pages, the thumbnail for the one currently selected for 

editing in the Canvas is surrounded by a white border.    

A (red border) indicates the page currently assigned as LiveText’s Live output. 

Jump to a specific page in your project by entering the page number in the Page field. Or you can 

cycle up or down through the pages by clicking on the neighboring arrow buttons.  Click a page 

thumbnail in the Pages panel to edit it (displaying it in the Canvas,) or double-click it to send it 

out Live. 

4.3.1.1 CLONE AND REMOVE 

Clicking the Clone button copies the currently highlighted page, inserting the copy below that 

page.  

Hint: Clone permits you to quickly and easily ensure pages conform to a particular 

graphic theme or format – just Clone an adequate number for you needs, then modify 

them individually. 

Clicking Remove deletes the currently selected page from the project (careful, there is no Undo 

for this action.) 

4.3.1.2 ADD PAGE 

You click the small arrow button beside Add Page to insert another page into your project.  New 

pages are added under the current page (and of course, they are not sent out as Live until you 

want them to be). 

The drop-down menu reveals a number of types of pages you can add.  The uppermost choices 

represent new blank pages of various types. 

Hint: You can also quickly add blank pages simply by clicking repeatedly in an empty black area of 

the thumbnail column – each click adds one empty page. 
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 This drop-down menu is home to a long list of professionally designed templates, ready and 
waiting for your modifications.  
 
As you scroll over the entries, a fly out thumbnail representation 
appears to make choosing something just right for your needs 
easy. 
 

Hint: Another selection in the Add Pages menu 

permits you to “Add Page to Templates List.” This 

lets you store the currently highlighted pages as 

LiveText templates, for quick access and consistent 

styling using templates of your own design. 

 

4.4 FILE MENU 

The File menu is in the upper-left corner of the LiveText desktop, and contains project and page 

file management tools.  These functions are considered in Chapter 5, File Management.  

4.5 THE TOOL PANEL 

The Tool Panel situated left of the Canvas provides the basic tools to create the text and graphic 

elements of your title page compositions, establish their relationships to one another if any, and 

set their primary attributes. 

4.5.1 TEXT AND DRAWING 

T (Text) 

Click on the T (Text) button to activate the text function. Before you enter 

text, this button must be highlighted. Click in the Canvas and an I-beam 

icon starts blinking. This is your Canvas cursor. When you type, the I-beam 

is the insert point for the text. You can move the I-beam anywhere on the 

Canvas by clicking it with your mouse and dragging it around or just 

clicking your mouse on another spot in the Canvas. 

Figure 23 

Figure 24 
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To edit the characters of any existing text, click your cursor anywhere on the line of text, and 

drag your mouse to select letters or whole words (selected character will be highlighted.) 

Hint:  Use the End and Home keys on your keyboard to navigate to the 

beginning and end of text lines. If you mistyped, you can use the Backspace key 

to erase or the keyboard arrow keys to go back or forth on the line or up and 

down between lines. 

Arrow (Selection) 

Clicking on the Arrow button activates the Selection tool (and switches off the Text tool). This 

selects the whole line, not just parts of it. If you have just typed something in, clicking the Arrow 

will create a box around what you typed. Select the line by clicking anywhere on it. 

When you roll your mouse over the box, the cursor changes form. When it becomes a two-

headed arrow, you can click to grab an edge of the box and drag it in or out to resize the text. 

When the cursor sprouts four arrowheads, you can click and grab the whole box to move it 

around the Canvas.  Hold down the Shift key over a corner of a selected object and a curved 

arrow cursor indicates you may now drag to rotate it. 

4.5.1.1 GRAPHIC SHAPE TOOLS 

The area immediately below the Arrow and T(Text) buttons is home 

to a number of tools used to create shapes.  Each shape is initially a 

separate graphic object. 

The tools are very easy to use, and just as easy to edit at any time 

after their creation, whether simply to adjust their position, or to add 

or modify much more elaborate treatments. 

For the most part, shapes are easily created by clicking one of the 
buttons, and dragging the cursor in the Canvas.  The shape responds 

interactively to your movements, and is created when you release the mouse button. 
 
Line  
To make a straight line, you simply click in the Canvas where you want the line to begin and then 
drag the mouse to where you want the line to end. 
 
Rectangle 
The Rectangle button creates outlines of four-sided objects. 

Figure 25 
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Filled Rectangle 
This tool works just like the Rectangle tool except it fills in shape with the same color as the 
outline. 
 
Arc 
The second row contains variations of ellipses. With the first, you can create segments of arcs. 
Click the mouse in the Canvas and drag to establish the radius of the arc, releasing the button 
when you are happy.  Then click and drag again to define the extent of the arc.  Release the 
button to complete it. 
 
Oval  
The Oval works just like the Rectangle tool. Click and drag in the Canvas to draw out your shape. 
 
Filled Arc 
The Filled Arc operation is the same as the Arc tool (see above). The only difference is that the 
arc created is filled in. Think of the Filled Arc as the pie chart tool. 
 
Filled Oval  
This tool works like the Filled Rectangle. 
 
Spline  
This tool and its siblings create freeform spline curve shapes. Click in the Canvas and release the 
mouse to establish the starting point.  Move to another spot on the screen and click again to 
establish a second node though which the spline will pass.  Continue to add nodes until you are 
satisfied, then double-click to end the curve.   
 
Closed Spline  
The technique for the Closed Spline is similar to the Spline: click in the Canvas, release the 
mouse, move to the next spot and click again, etc... With this tool though, nodes are 
automatically connected to the first (anchor) point to create an enclosed object. When you’re 
finished, simply double-click. 
 
Closed Filled Spline 
This tool works just like the Closed Spline tool except it fills in shape with the same color as the 
outline.  
 
Polygonal Line 
 This tool functions like the Spline except it doesn’t create a curve between the nodes. You click 
in the Canvas to establish your anchor point, release the mouse and move to your next spot, and 
click to create a node. A straight line will connect the two points. Move and click again and a line 
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will connect this point with the previous one. With this tool, a sharp angle is maintained at the 
intersection of the lines. You double-click at the last point to finish. 
 
 
Polygon 
 This tool works like the Polygonal Line, except as soon as you create the first node, it’s 
connected to the anchor point, automatically creating an enclosed object. 
 
Filled Polygon 
 This tool works just like the Polygon tool except it fills in shape with the same color as the 
outline. 
 

 

 

Color - The large color well below the drawing tools permits you to set a base color for 

the objects you create using the tools.  Left click it to open the Color Picker panel, or right 

click and drag to use an eye dropper cursor to pick a color from the screen. 

Note: Extensive control over color is provided in the Color section of the tabbed Control 

Panel discussed a bit further on in this chapter. 

4.5.1.2 OBJECT MANAGEMENT 

Completing this section are essential basic editing tools: Cut, Copy, Paste, Delete, Undo, and 

Redo. The traditional Windows keyboard shortcuts also work: 

 

Figure 27 

 Cut — Ctrl + x 

 Copy — Ctrl + c 

 Paste — Ctrl + v 

 Delete — Delete key 

Figure 26 
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 Undo — Ctrl + z 

 Redo — Ctrl + y 

4.5.2 ALIGNMENT 

The alignment panel permits quick and easy positioning and re-ordering of objects on the 

Canvas. 

4.5.2.1 HORIZONTAL JUSTIFICATION 

The top row of buttons in this section control horizontal justification buttons, aligning text as are 

commonly found in word processing programs. 

Left Justify - aligns your text to begin just inside the left edge of 

the Text Safe Area 

Center - aligns the center of the line(s) with the center of the 

Text Safe Area. 

Right Justify - aligns your text so the end of the line(s) is just 
inside the right edge of the Text Safe Area. 
 
 
 
 

4.5.2.2 VERTICAL JUSTIFICATION 

Each of the buttons in the next row justifies your text within the vertical Safe Text area of the 

screen. 

Top - aligns your text just below the upper limit of the Text Safe Area. 

Center - centers your text vertically in the Text Safe Area. 

Bottom - aligns your text just above the lower limit of the Text Safe Area. 

Figure 28 
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4.5.2.3 DEPTH CONTROL 

Text and objects in the Canvas which occupy the same space are normally displayed in the order 

created – first items to the rear, as it were, with newer object in front.  The depth controls in this 

section permit you to modify this order.  Select an object (or line of text) and click once to move 

one step relative to other objects. 

Bring Forward – move the selected item forward 

Send Backward – move the selected item back 

Note:  The Layers section of the tabbed Control Panel (discussed in Section 0) provides 

an alternative (and often more convenient method) of re-ordering objects and text. 

4.5.2.4 GROUP /UNGROUP 

 Even though each line of text and graphic object is really a separate entity, you can select 

multiple lines and Group them together to respond to modifications in unison.  

The UnGroup button undoes the union. Hold down the Ctrl key while clicking multiple items or 

lines of text and press the Group button. The bounding boxes are now replaced by a single 

bounding box. Hit UnGroup again, and the lines become separate entities once more. 

4.6 THE MOTION PANEL 

 

Figure 29 

The Motion Panel contains the tools to create both scrolls and crawls.  This is where you control 

the direction, speed and behaviors of your crawls and scrolls. 

The No Motion button and Direction arrows are self-explanatory. If you want a text crawl from 

left to right, pick the right pointing arrow. For a scroll moving up, choose the up arrow, etc. 
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4.6.1 SPEED CONTROL 

In the Motion Speed field, choose a specific rate of motion in units of ‘pixels per frame.’ 

Fun with math: For a text crawl across an NTSC format screen, knowing that the screen 

is 720 pixels and there are roughly 30 frames per second, you can readily work out a 

suitable value.  To have an object or text item crawl from one side to the other in four 

seconds, 720 divided by 120 (30 frames per each of the 4 seconds) equals 6. 

If motion pages move too quickly, motion may not appear smooth. A common preference is for a 

line of text to take about seven seconds to travel from the bottom of the screen to the top. You 

may wish to test the speed out on a TV monitor to see if it suits you. 

4.6.2 END BEHAVIOR 

The End Behavior setting in the Motion Panel determines what happens when an animated page 

runs its full course. 

 Over tells the CG to scroll or crawl the page once, and then stop when the page has left 

the screen. 

 Stop tells the CG to scroll or crawl the page once and then to hold on the last line of 

text. 

 Loop tells the CG to loop the page continuously. 

 Loop + Frame tells the CG to loop the page continuously and to place a blank frame 

between loop repetitions. 

4.7 CONTROL PANEL TABS 

 

Figure 30 

Near the bottom of the screen (beneath the Motion Panel) is the multi-tab Control Panel. The 

individual panels provide precise command of countless text and graphic object attributes, 

organization, and management. 
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4.7.1 VIEW 

 

Figure 31 

The View tab reveals three sections, Grid, Guides and Display.  These all add one or another type 

of overlay to the Canvas above, as an aid to composing your graphic and text pages on.  As you 

would expect, none of the overlay elements appear in the final output. 

GRID 

Define a grid to help you align objects on the 

Canvas in specific arrangements.   

The two numeric entry fields with associated 

mini-sliders adjust the width and height of 

cells in the grid.  

 

The Grid switch toggles the grid overlay on/off. Enabling Snap effectively makes the lines of the 

grid somewhat magnetic - you are not restricted to placing items exclusively along the grid lines, 

but the cursor is drawn toward them, making it easy to do so if you wish. 

GUIDES 

This feature is somewhat similar, in that it offers 

overlaid lines and a similar Snap feature.  However, 

rather than displaying a full grid, you define where the 

lines will go – add just one guide line, or as many as you 

like.   

 

To add a Guide, Rulers must be enabled in the Display section.  Click in the calibrated ruler 

display, (horizontal or vertical), and drag the cursor across the Canvas.  Release the mouse 

Figure 32 

Figure 33 
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button when the new Guide is positioned where you want it to go.  If you hover the cursor above 

a Guide, it becomes a double-headed arrow that you can drag change the Guide’s position. 

Use Clear Guides to remove all existing Guides from the screen. 

DISPLAY 

Traditional television displays crop the image area of 

video somewhat. 

For this reason, it’s customary to allow a certain 

amount of ‘safe area’ on the margins of the screen – 

to make sure that important text displays or action 

are not inadvertently cut off for viewers. 

 

The Safe Area switch in the Display pane enables an overlay on the Canvas.  The lines make it 

easy for you to create your title pages with these overscan limitations in mind.  Inner rectangles 

mark the 4:3 Text Safe area and outer boundaries, while the outermost lines show the edge of 

the entire 16:9 page. 

For very complex pages, it can be useful to enable the Wireframe switch.  While enabled, this 

removes opaque color from objects on the Canvas window, leaving only an outline through 

which other items can be seen. 

Checkerboard replaces the default black Canvas background with two-tone checks (these do not 

appear in exported title pages, of course).  Finally, the Rulers option provides another level of 

precision when preparing your title pages by adding calibrated scales to the display.  (And, as 

noted a moment ago, you add Guides to the Canvas using the Rulers.) 

4.7.2 TEXT AND DRAWING 

 

Figure 35 

This tab provides primary control over all text and graphic object attributes.   

Figure 34 
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4.7.2.1 FONT AND ORIENTATION 

FONT 

The drop-down Font menu allows you to choose from your installed typefaces.  Bold, Italic, and 

Underline buttons are to its right, along with another basic face color well. 

The Width and Height controls are locked proportionally when the neighboring Lock Aspect 

Ratio control is lit up. Rotate adjusts the exact degree of rotation (on the Z axis.) 

Tracking adjusts the amount of space between neighboring pairs of letters. 

Hint: You can also adjust tracking interactively in the Canvas.  Place the cursor between 

letters and hold down the Alt key while using the arrow keys to add or reduce spacing.  

Leading adjusts the amount of vertical space between text lines. Multi-select the lines you wish 

to adjust using CTRL + click (or by dragging a rectangle around them in the preview window), and 

raise or lower the Leading value to suit your need. 

ORIENTATION 

Rotate changes the orientation of text and 

drawing objects. Hold During Motion, when 

enabled, ensures that the selected object does 

not move as an element within Scroll or Crawl 

pages. Do Not Render prevents the image from 

being displayed as part of the page when 

displayed or rendered. 

ARC/LINE 

The Joint menu options affect way corners of a 

drawn CG object are created – choose from 

Round, Bevel, or Square. Similarly, the End menu 

selection determines whether the ends of a line object terminate in a Square, Round, or Point. 

 

Figure 36 
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Arc Start and End values permit great precision for Arc and Filled Arc objects, and the Thickness 

value is pretty much self-explanatory. 

EDGE 

Edge refers to a two-tone border that conforms to character or object shape.  The way corners 

are painted is controlled by the drop-down menu – options are Round, Square, or Bevel. 

The two boxes to the right of the menu are where you choose the colors for the inside and 

outside edges of the border applied around your objects.  Inside color is the box on the left, 

outside color is on the right. 

Click in the box to bring up the Color Picker panel, or right-click it to activate the Eyedropper tool 

to choose a color from the Canvas. 

SHADOW 

Shadow options include Cast, Drop, and Soft (the numeric Soft setting is only relevant to the 

latter.)  The Italic setting permits you to shear the Shadow independent of the ‘shadow-casting’ 

object, and the X and Y fields control the amount of offset for the shadow. 

NOTE: Images with Shadow option enabled cannot serve as ‘stand-in images’ (see Section 1.3). 

4.7.3 THE COLOR TAB 

The Color tab provides the control over characteristics for coloring and texturing objects, 

including text. 

 

Figure 37 

4.7.3.1 COLOR DESCRIPTION 

Use the Edit menu to specify which aspect of a text line or graphic object you intend to modify. 

There are three choices:  Fill controls colors used in the body of the font or object.  Choosing 

Edge or Shadow restricts modifications one of those characteristics.  
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Type permits you to choose between six different types of color (or image-based texture): 

Choosing Solid for Type applies a single color to the surface (the 

one in the neighboring Solid Color pane).  When you pick one of 

the middle four instead (Linear, Corners, Angle, or Radial), the 

current Gradient colors are applied. 

Linear (Type) applies the Gradient in a straight left-to-right 

pattern. Corners will apply the gradient color starting at the upper 

left corner diagonally, sweeping around to the bottom right.  

Angle applies the Gradient starting at 3 o’clock and rotating 

counterclockwise.  

Radial applies the Gradient starting at the center of the surface and emanating to the edge. 

Texture applies an image map (specified using the Image drop-down menu in the Solid Color 

Pane at right) to the surface. 

Adjusting the Rotate value changes the application angle for the gradient or texture, when 

active. 

SELECTION, LINE & CHARACTER  

If you have multiple lines of text on a page, you can choose how 

the color, gradient, or texture will be applied.   

Selection fits your settings to selected characters or objects 

(including multiple selections.)  Line applies them independently 

to each line of text, while Character applies the texture 

independently to each character. 

Note: In reality, each text line is always a separate object.  If you select just part of a text 

line (in the Canvas while in T(Text) mode (whether by dragging the mouse or using Shift 

with the arrows keys), and apply different settings, the line will split into two objects to 

accommodate your wishes.  You may want to use the Group function to permit you to 

continue treating the line as a single object subsequently. 

 

Figure 38 

Figure 39 
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4.7.3.2 THE GRADIENT PANEL 

The gradient panel provides awesome color control, allowing you to create and apply many 

beautiful effects.  

GRADIENT PRESETS 

The upper section of the Gradient 

Panel contains a goodly number of 

presets, represented visually. 

Scroll up and down through the 

selections using the arrow buttons at 

right, and simply click a gradient you 

like to activate it (replacing the 

content of the gradient edit pane 

below.)   

Use Add to send the current gradient to the presets list, or Remove to clear a preset. 

The dotted vertical lines in the gradient preview pane mark the nodes of specific color values 

that define the gradient.  You can drag these left or right interactively, or select one by clicking 

directly on it, and Move it using the mini-slider control at right.  The display updates immediately 

to show the results of the changes you make. 

Add a new node by double-clicking in the gradient preview.  Delete a selected node using the 

Delete button, and set its color using the Node Color well.  You can also separately adjust the 

Bright(ness) of nodes using the mini-slider at right. 

To multi-select nodes for certain operations, you can click them one at a time with the Ctrl key 

depressed or drag out a marquee around them right in the editor (a shaded box shows the 

selection zone in this case.)  With one or more nodes selected, each time you drag the Clone 

slider, another set of duplicate nodes is created. You can also clone one or more nodes by 

holding down Ctrl and dragging left or right in the gradient preview pane.  Scale expands or 

contracts the distance between multi-selected nodes. 

Clear Gradient lets you start fresh, while Loop Gradient allows the gradient to repeat itself, so 

that the color at one end loops seamlessly to the opposite end (this control has no effect when 

nodes exist at each end of the gradient.) 

Figure 40 



 

31 

4.7.4 THE STYLE TAB 

 

Figure 41 

The Style tab allows you to add gorgeous and complex treatments to your text and graphic 

objects with a single click.  It is also a great way to ensure consistency for the title slates you use 

in your productions! 

To apply a Style preset, simply select a line of text or an object in the Canvas, and then click a 
representative thumbnail in the Styles pane.  Create your own custom look, and add it to the 
Styles list using Add, and of course, remove those you don’t care for using Delete. 

4.7.5 THE FILEBIN 

You can drag image, .cg or .TXT file icons right onto the Canvas directly from this Filebin.  

(Loading a .CG file in this manner replaces the current project.)  

 

Figure 42 

Above the file window is a menu with navigation and file management buttons at left, and a file 

icon preference menu at right.  More detail on the various features of the Filebin can be found in 

Chapter 5 - File Management. 
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4.7.6 THE LAYER TAB 

The Layer tab provides a convenient way to select various text and CG objects on the Canvas, 

modify their relative ‘depth’ or alignment, and more. 

 

Figure 43 

At times the Canvas can become rather cluttered, making it tricky to select text lines or objects 

directly by clicking.  The final tab provides a convenient alternative. Each item in your current 

page is represented by an individual line in the Layers tab. 

 

Figure 44 

Consider the situation above showing a line of text that, unfortunately, is occluded by a rectangle 

object. Re-ordering layers is a simple matter in the Layers tab. 
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Figure 45 

Simply drag the line for the rectangle above the text line with the mouse.  The insertion point 

where the current selection will be dropped when you release the mouse is shown by a thick 

white line. 

Objects nearest the top of the list will appear 

further back in the result – appearing behind 

objects that appear lower down in the Layers 

list. 

 

 

Multi-select objects by dragging a box around them in the Canvas window, and click a button in 

the Align section to line them up.  

The last object selected will be brightly highlighted in the Layer tab, and will be the one 

that other objects align to. 

4.7.6.1 TAGGING LAYERS 

The NewTek Developer Library provides tools that permit third-party developers to extend 

TriCaster’s integrated titling capabilities in powerful ways. 

For example, a custom external application might be prepared that could update specific text 

lines and images on a title page, then display it.  Text lines or images in title pages may be 

targeted using their object indices, but a friendlier method of identifying objects is to use ‘tags’. 

Figure 46 
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Tags are custom nicknames given to individual items on the title page to make it easy to identify 

and address them.  Though not visible in the TriCaster interface (apart from within the LiveText 

application), tags can thus be very useful. 

 

Figure 47 

To add custom tags to objects on a title page, use the Layer tab.  Simply double click on an entry 

in the Layer tab and type in the tag (Figure 47). 

4.8 OPTIONS AND KEYBOARD CONTROL 

An extensive list of Keyboard Shortcuts is available (for example, pressing Alt + F2 toggles the 

Safe Area overlay in the Canvas on and off.)  Press F1 to view shortcuts (please see also Appendix 

A – Keyboard Shortcuts). 
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5 FILE MANAGEMENT 

 

 
Title pages and projects created in LiveText can be utilized in a surprising 
number of ways. Going ‘direct to air’ in a live production is amazing 
enough, but there are also many other benefits to LiveText, too! 
 
This chapter explores the options available, whether in connection with 
immediate live display or for other purposes.  As well, it explains the 
many convenient and useful features available in LiveText’s file windows. 
 
 

 

5.2 FILE EXPORTS 

LiveText pages exported as bitmap format files (.png, .avi) can be used creatively in the DDR and 

Picture modules of compatible live broadcast systems (such as TriCaster). 

LiveText also exports Title Page files (.cgxml) for use in the Media Players (DDR, Stills, Titles) 

found in the Live Desktop of TriCaster TCXD series systems. 

Image and animated pages (both bitmap and .cg formats) exported from LiveText can also be 

used in connection with SpeedEDIT 2 video editing projects. 

CGXML Title Page Notes:  TriCaster live Title Page format (.cgxml) presently supports almost 

every attribute that LiveText offers – but there are a few exceptions. 

For example, multiple font properties on one text line are not supported, which means in turn that 

different words on a single line cannot be different colors, or use different typefaces.  Of course 

you can achieve the same effect by using additional text objects as necessary. 

For similar reasons, text entered as paragraphs is automatically split into multiple lines in .cgxml 

Title Page files. (Supplemental support for paragraph text is provided in current LiveText versions 

for use with TriCaster Advanced Edition.  This allows long text strings, and even multiple 

paragraphs, to wrap correctly inside the bounding box defined by your text entry on the LiveText 

canvas.) 
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5.2.1 FILE MENU 

 

Figure 52 

The File menu is in the upper left corner of the LiveText desktop.  It contains project and page file 

management tools.  Projects and (editable pages) are stored as *.cg files.   

Choosing New clears the current project, and opens a new blank one. (LiveText’s custom file 

explorer is discussed in detail shortly, in Section 5.3). 

Open also clears the current project, replacing it with another a .cg file (a LiveText project) you 

have previously created and saved (see the note in Section 4.3 re: legacy LiveText projects). 

5.2.1.1 ADD FILES (IMPORTING) 

Add Files can be used to add an image or even a text file (see below) to the current LiveText 

page.  Alternatively, you can change the file suffix in the file requester to show files ending in 

“.txt”. 

This permits you to import long lists of textual data prepared in standard ASCII text format and 

saved as a .txt file.  This feature will be discussed a bit later, in Section 5.3.1.6. 

Note: You may find it preferable to add files using the Layers tab (discussed next) to drag 

files onto the Canvas. At the time of writing, ‘adding’ a .cg file replaces the current 

project. 
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5.2.1.2  PROJECT (SAVE AS) 

Save the current project with all of its component pages as a LiveText project file (.cg).  Saved 

files may be reloaded later of course, and may also be compatible with selected CG applications 

in the NewTek family. 

This latter option opens up possibilities similar to those discussed next under Export Current 

Page. 

5.2.1.3 EXPORT CURRENT PAGE 

 

Figure 53 

Export Current Page can export a single CG Page (.cg is LiveText’s project file format), convert 

the highlighted page into a Still Image file format (.png file format), or a Title Page file (.cgxml) 

for live production use with TriCaster systems.  If the current page is a motion page (Scroll or 

Crawl), the File Type options include CG Page and Video for Windows (.avi file format). 

You can choose common NTSC or PAL video resolutions when saving either still or animated files 

using the Resolution menu options. 
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Exported page types (other than .cg) can be added to the playlist of a DDR module (or Picture 

module) on selected live production systems, and applied via the Overlay module; or you may 

use them in non-linear editing applications.  If the page(s) contain transparent areas, the 

transparency will be retained. 

Project files (.cg) can be imported into compatible software, or re-imported into LiveText.  When 

loaded into selected titling applications (such as the TriCaster’s Edit Text), it is possible to use 

those application’s own native export features to create Text Templates or even LiveSet™ shots 

for creative use.   

An example of using LiveSet™ for a CG purpose would be to apply an ever-present 

station ID overlay (‘bug’) to the program stream. (Using a LiveSet shot for this chore 

leaves the system’s Overlay section free for other purposes.) 

 

5.2.1.4 EXPORT ALL PAGES 

This export feature works much like Export Current Page. The primary difference is that all pages 

comprising the current project are exported. 

The Title Page (.cgxml) file export type does not support motion pages – hence if you choose that 

alternative, LiveText will automatically prepare .avi clips for any motion pages encountered as it 

exports the project pages. 

If the current page when you select Export Current Page is a still, the File Type menu offers 

export as Still Image (*.png).  Nevertheless, LiveText will again automatically prepare .avi clips for 

any motion pages encountered as it exports the project pages. 

 

5.3 FILEBIN FEATURES 

LiveText features custom file browsing features used in connection with loading and saving 

various file types.  Two file browsers are provided – the one used in connection with File menu 

selections, and the main Filebin - a tabbed panel underneath LiveText’s Canvas and Motion 

Control pane. 
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Figure 54 

For the most part, although the layout of the two file panes varies slightly, the features are quite 

similar, and you should quickly become comfortable with them. 

5.3.1.1 VIEW OPTIONS 

The largest part of either file browser is 

the file list window.  

In the default view (and several of the 

optional ones) you will see a large 

thumbnail image icon to represent any 

image file.    

This view can be personalized to suit 

your need or taste in several ways.  

 

 

 

A drop-down menu in the upper-right corner of the pane controls the appearance of items in the 

file list window.  By default this menu is set to Large Icon. You can use this menu to radically alter 

the appearance and features of the panel. Try the different view options out, and you’ll quickly 

see how they affect the display. 

Figure 56 Figure 55 
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The only view option that requires a little longer explanation is the Details view (Details Only is 

similar, but minus the file icon.) The Details view gives you a lot of in-depth information about 

your files. 

 

Figure 57 – Filebin tab, Details View 

5.3.1.2 NAVIGATION  

In standard fashion, double-click a folder or drive shown in the file list window to enter it, 

displaying its content. 

 

Figure 58 

Above the file list pane, a row of rectangular text boxes appears (Figure 58) as you navigate down 

into your directory structure.  These text boxes show the directory path of the current view. Click 

directly on a text box to jump back to that drive or folder location. 

 

Figure 59 

Nearby you will find buttons labeled Back and Forward (or triangular forward and back gadgets.)  

These work just like the similar features found in an internet web browser.  
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THE HOTLIST 

If you have a folder you frequently access, you can add it to the Hotlist at the bottom of file 

windows. Navigate to the folder you want to add, and press the ‘+’ sign at left corner (click the ‘-‘ 

sign to remove the current Hotlist button.)  

 

Figure 60 

When you right-click directly on a Hotlist button, a two-item menu pops up.  You can Remove 

the selected entry, or Rename it.  The Rename option creates a ‘nickname’ for the current folder, 

and refreshes the Hotlist to display it. (If your list is wider than the bin, there is a scroll gadget 

lower right.) 

5.3.1.3 CUT, COPY, PASTE, DELETE 

Cut, Copy, Paste and Delete buttons are also located here.  These operate on the currently 

selected items in the file list window.   

Of course, the common keystroke shortcuts also work in the usual manner (CTR+c for 

Copy, CTRL+v for Paste, CTRL+x for Cut, and the DEL key to Delete a file.) 

The New Folder button creates a new directory at the current level, and pops up a small dialog 

allowing you to change its name on creation.  Alternatively, you can create a New Folder from 

the menu that appears when you right-click in an empty spot in the file list window. 

5.3.1.4 FILE SELECTION 

As you’d expect, simply clicking a file in the file list window selects it.  If you click one file and 

then hold Shift down when you click another, you can select all the files in between.  Or, click 

multiple files (in any order) while holding down the CTRL key to select a number of files which are 

not next to each other in the file list. 

5.3.1.5 FILEBIN OPERATIONS 

The tabbed Filebin panel (under the Canvas) is unique in that it has no ‘add’ or ‘save’ (etc.) 

buttons.  Really, this Filebin is intended for quick and convenient interactive use. Simply drag a 
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file onto the Canvas to load or import it.  When the file is a .cg file, the current LiveText project 

will be completely replaced by the import.  On the other hand, if you drag an image file into the 

Canvas, it is added to the current page.  

Text files (in standard ASCII .txt format) are a special case.  Dragging a text file onto the Canvas 

(or importing one using the File menu) triggers a powerful feature, described next. 

5.3.1.6 IMPORT TEXT 

If you drag an (ASCII) file onto the 

Canvas from the tabbed Filebin, the 

Import Text panel pops up.  

This panel offers numerous controls 

over the manner in which the lines of 

text in the file are treated on import, 

and how multiple pages will be 

generated as necessary for them. 

You can create a new page for each line of text, or form a single long page containing multiple 

lines.  As well, you can control placement of the text on the newly created page(s) using the 

Alignment, Preset or Custom Position buttons.

Figure 61 
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6 APPENDIX A – KEYBOARD SHORTCUTS 

 

Show Keyboard Shortcuts F1 

6.1.1.1 FONT 

 

Font Name (next/previous) F5  (Shift +) 

Font Size F6  (Shift +) 

Font Rotation F7  (Shift +) 

Font Tracking (Spacing) F8  (Shift +)  

6.1.1.2 TEXT 

 

Increase/decrease Width by 5 pixels Alt w  (Shift +) 

Increase/decrease Height by 5 pixel Alt h  (Shift +) 

Increase/decrease Edge by 1 pixel Alt k  (Shift +) 

Increase/decrease Italic by 1 pixel Alt i  (Shift +) 

Increase/decrease Tracking by 1 pixel Alt space  (Shift +) 

Next/Previous Font Alt f  (Shift +) 
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6.1.1.3 CLIPBOARD 

 

Select All Ctrl a 

Deselect All Ctrl d 

Cut Ctrl x 

Copy Ctrl c 

Paste Ctrl v 

Delete Del 

Redo Ctrl y 

  

Undo Ctrl z 

6.1.1.4 TEXT ENTRY 

 

Select One character Shift + L/R Arrow 

Move curser to beginning  Home 

Move curser to end End 

Select to the beginning Shift + Home 
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Select to the end Shift + End 

Delete entire trailing word Ctrl + Delete 

Select entire line Shift + Up/Down Arrow 

Kerning by letter Alt + L/R Arrow 

Move and scale LMB (Left Mouse Button) 

Rotate and Spacing LMB + Shift 

Multi-Select by area LMB + Drag 

Multi-Select Individual Objects LMB + Ctrl 

6.1.1.5 MODIFY TOOL 

 

Nudge Up 1 pixel Up Arrow 

Nudge Down 1 pixel Down Arrow 

Nudge Left 1 pixel Left Arrow 

Nudge Right 1 pixel Right Arrow 

Nudge Up 10 pixels Shift + Up Arrow 
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Nudge Down 10 pixels Shift + Down Arrow 

Nudge Left 10 pixels Shift + Left Arrow 

Nudge Right 10 pixels Shift + Right Arrow 

6.1.1.6 ALIGNMENT 

 

Left Safety Alt l 

Center Safety Alignment Alt c 

Right Safety Alt r 

Bottom Safety Alignment Alt b 

6.1.1.7 LAYOUT 

 

Align Left Alt Shift l 

Align Alt Shift r 

Align Top Alt Shift t 

Align Bottom   Alt Shift b 

Align Horizontal Center Alt Shift c 



 

47 

Align Vertical Center Alt Shift v 

6.1.1.8 PAGE 

 

Add a new page Ctrl Insert 

Delete Current Page Ctrl Shift Delete 

Clone Current Page Ctrl Shift Insert 

Move up the Page list PageUp 

Move down the Page list PageDown 

Move to top of Page list Ctrl PageUp 

Move to bottom of Page list Ctrl PageDown 

6.1.1.9 SHADOW 

Add (Sub) 1 to Shadow Offset X Alt x  (Shift +) 

Add (Sub) 1 to Shadow Offset y Alt y  (Shift +) 

Shadow Type (up/down) Alt F5  (Shift +) 

Shadow Size (raise/lower) Alt F6  (Shift +) 
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Shadow Angle (raise/lower) Alt F7  (Shift +) 

Shadow Softness (raise/lower) Alt F8  (Shift +) 

6.1.1.10 EDGE 

 

Edge Type (up/down) Ctrl F5 (Shift +) 

Edge Size (raise/lower) Ctrl F6 (Shift +) 

6.1.1.11 VIEW 

 

Toggle Safe Area on and off Alt s 

6.1.1.12 FILES/FILEBIN… 

 

Open Ctrl + O 

Save Ctrl + S 

Save As Ctrl + Shift + S 

Add Files Ctrl + I 

New Folder Ctrl + N 

File Properties Ctrl + D 
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Back Backspace 

Forward  Shift + Backspace 

Selection…  

Select All Ctrl + A 

Deselect All  Ctrl + Shift + A 

First Item Home 

Last Item End 

Previous Item Left/Up Arrow 

Next Item Right/Down Arrow 

Previous Item and Keep Current Selection Ctrl + Left/Up 

Next Item and Keep Current Selection Ctrl + Right/Down 

First Item and Keep Current Selection Ctrl + Home 

Last Item and Keep Current Selection Ctrl + End 

Select All Previous Items Shift + Home 

Select All Previous and Keep Current Selection Ctrl + Shift + Home 
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Select All Following Items Shift + End 

Select All Following and Keep Current Selection Ctrl + Shift + End 

6.1.1.13 LIVE 

 

Send current page to live F9 

Play current live motion page (toggles play and pause) F10 

Pause current live motion page F11 

Stop current live motion page F12 
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